
 

 

 

 

Operation Instructions 

for 

HART Configuration Software 

Model: NUS-NTB-NRM-SW Software 
 
  



NUS-NTB-NRM-SW Software 

page 2  NUS-NTB-NRM-SW Software V2.1-K08/0625 

 

1. Contents 

 
1. Contents ............................................................................. 2 
2. Note .................................................................................... 3 

2.1 General ........................................................................ 3 
2.2 Hazard warnings .......................................................... 3 

3. Instruction ........................................................................... 4 
4. Measurement system ......................................................... 6 
5. Software installation ............................................................ 7 
6. Usage of NUS-NTB-NRM-SW Software ............................. 7 

6.1 Installation of NUS-NTB-NRM-SW Software ................ 7 
6.2 Add network ................................................................. 9 
6.3 Scanning devices ....................................................... 11 
6.4 Select device(s) .......................................................... 12 
6.5 Device settings ........................................................... 13 
6.6 Start measurement ..................................................... 14 
6.7 Trend logging ............................................................. 16 

7. Detailed description of the software .................................. 20 
7.1 Running the application .............................................. 20 
7.2 Running the application .............................................. 20 
7.3 Elements of the main screen ...................................... 21 
7.4 Connection settings .................................................... 23 
7.5 Toolbar ....................................................................... 24 
7.6 Device settings ........................................................... 30 

8. The Popup menu .............................................................. 38 
8.1 Elements of the Popup menu ..................................... 38 
8.2 Trend diagram ............................................................ 39 
8.3 Status ......................................................................... 43 
8.4 Linearization (VMT - Volume Mass Table) ................. 44 

9. Tools menu ....................................................................... 48 
9.1 Parameter file editor and viewer ................................. 48 

10. Disposal ............................................................................ 52 
 

 
 
 
Manufactured and sold by: 
 

Kobold Messring GmbH 
Nordring 22-24 
65719 Hofheim 

Tel.: +49(0)6192-2990 
Fax: +49(0)6192-23398 

E-Mail: info.de@kobold.com 
Internet: www.kobold.com 

 



 NUS-NTB-NRM-SW Software 

NUS-NTB-NRM-SW Software V2.1-K08/0625 page 3 

2. Note 

2.1 General 

Before unpacking and commissioning the device, the operating instructions and 
the “General Safety Instructions” document must be read and followed carefully. 
The general safety instructions, the operating instructions, the data sheet as well 
as approvals and further information can be downloaded via the QR code on the 
device or under the respective product on www.kobold.com. 
 
Due to technical changes, the device documentation available online may not 
always correspond to the product version you have purchased. If you need an 
instruction manual that corresponds to the purchased product version, you can 
request it from us free of charge by email (info.de@kobold.com) in PDF format, 
specifying the relevant invoice number and serial number. If you wish, the 
operating instructions can also be sent to you by post in paper form. 
 
Operating instructions, data sheet, approvals and further information via the QR 
code on the device or via www.kobold.com 
 
The devices are only to be used, maintained and serviced by persons familiar 
with these operating instructions and in accordance with local regulations 
applying to Health & Safety and prevention of accidents.  
 
When used in machines, the device should be used only when the entire machine 
fulfils the EU machinery directive. 
 
 

2.2 Hazard warnings 

The following instructions are intended to ensure your personal safety and to 
prevent damage to the product described or connected devices. Safety 
instructions and warnings to prevent danger to the life and health of users or 
maintenance personnel, or to prevent damage to property, are highlighted in this 
documentation using the symbols defined here. The symbols and terms used 
have the following meaning in the documentation itself: 
 
Symbol Explanation Symbol Explanation 
 

 
 
Note 
 

Is important information 
about the product, the 
handling of the product or 
the respective part of the 
documentation to which 
particular attention should 
be drawn. 

 

 
 
Caution 

Means that minor personal 
injury or minor property 
damage may occur if proper 
precautions are not taken. 
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Symbol Explanation Symbol Explanation 
 

  
 
Warning 
 

Indicates that serious 
personal injury or 
substantial property 
damage may occur if 
proper precautions are not 
taken. 

 

 
 
Danger 

Means that death can occur if 
proper precautions are not 
taken. 

 
Warning 
 

Attention: Hot surface!  

 
 
Warning 

Warning: Dangerous electrical 
voltage 

 
 
 

3. Instruction 

The HART ("Highway Addressable Remote Transducer") is a popular digital 
communication protocol designed for industrial process measurement 
applications. The special feature is that it uses a low-level modulation 
superimposed on the standard 4-20 mA current loop, which is now widely used 
for such measurements. Since the HART signal is small, and composed of sine 
waves, its average value is zero and does not significantly affect the accuracy of 
the analogue current signal, which can therefore still be used. This provides 
compatibility with existing systems, while allowing simultaneous digital 
communication for device configuration, status checking, diagnostics and so forth. 
The NUS-NTB-NRM SW Software 
has been designed for detection, polling and displaying primary measurement 
data as well as remote programming of KOBOLDS HART-capable transmitters. 
The NUS-NTB-NRM-SW is able to handle maximum 15 units in one Node and 
able to handle up to 10 Nodes. 
Installed in a PC the software allows the menu driven remote programming 
(device parameters + HART commands). The software can collect data from the 
detected KOBOLD units and perform cyclic polling and displaying the 
measurement data. 
 
Provided functions of NUS-NTB-NRM-SW Software: 

 Detection of the connected devices (also in Multidrop operation mode) 
 KOBOLD manufactured device specific commands: 

 Downloading parameters from field device 
 Editing, uploading parameters into the field device 
 Loading parameter list from file, saving parameter list to file 
 Downloading linearization table from field device 
 Editing, uploading linearization table into the field device 



 NUS-NTB-NRM-SW Software 

NUS-NTB-NRM-SW Software V2.1-K08/0625 page 5 

 Loading linearization table from file, saving linearization table to file 
 Display Echo Map (for non-contact principle devices) 
 Downloading service and information parameters 
 Sensor calibration (NUS, NTB, NMS, NMB, NRM, NRE) 
 Security password (protection against unauthorized usage) 

 
 

 
 
Note 

Note! However, the NUS-NTB-NRM-SW Software makes setting of 
parameters easier in remote programming, the profound knowledge 
of the parameter system of the kobold transmitters is indispensable. 
The NUS-NTB-NRM-SW Software provides data logging capability for 
max. 3 hours. 
The NUS-NTB-NRM-SW software is acting as primary master on the 
network. While running the software, the use of an active secondary 
master unit (for example a hand-held communicator) is strictly 
FORBIDDEN! 
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4. Measurement system 

System requirements: 
 Win XP, Win 7 32 or 64 bit 
 HART modem (e.g.: KOBOLD’s HARTCOM-X) connected to a virtual COM 

port 
 

The HART modem establishes communication line between HART-capable field 
devices and process controller computer. 
The HART modem is applicable for all HART-capable transmitters which use 
standard HART communication. 
 
WIRING EXAMPLES: 
 

1. HARTCOM-1 with transmitter power supply and 250 Ω integrated 
 

 
2. HARTCOM-0 with external 24V DC transmitter voltage and 250 Ω resistor 

 

HARTCOM-1

HARTCOM-0
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5. Software installation 

The software does not require installation, however prior to run the application we 
recommend installing the FTDI Driver (Virtual COM-PORT), available to download 
from the website of FTDI (http://www.ftdichip.com/Drivers/VCP.htm). 
 
 
 

6. Usage of NUS-NTB-NRM-SW Software 

6.1 Installation of NUS-NTB-NRM-SW Software 

Please download the HART-configuration-software for the NUS, NTB and NRM 
devices from our homepage www.kobold.com under product search “NUS”, “NTB” 
or “NRM”, selecting the device type. 
Install the software on the PC, start the setup.exe file and follow the instructions 
on the screen. 
 
 

 
 
Select destination and click next. 
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Select the folder in the start menu. 

 
 
 
Click install to continue with the installation. 

     
 
 
Click finish to exit setup. 
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6.2 Add network 

Click the Add Network button. (Further details are described in chapter 7.4.) 
 

 
 

Choose the communication port. 
 

 
 
 

 

 
 
Note 

Note! The NUS-NTB-NRM-SW Software is able to handle multiple 
(Nodes) current loop networks (maximum up to 10). If there is more 
than one current loop click again on the „Add Network” button (and 
repeat the same procedure as before) to add further current loops to 
the Node list. Switching between the loops can be done with the 
pages on the upper bar and the networks also appear in the „Node 
List” window. 
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6.3 Scanning devices 

Click the Detect  button. 
 
The Detect start all node button in the upper menu bar starts the device 
detection in all the connected communication ports, and the Detect button in the 
lower toolbar starts the device detection only on the selected communication port. 
(Further details are described in chapter 7.5.2.) 

 

 
 

The below Scanning network window appears when the detection starts. 
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6.4 Select device(s) 

 
To select between the detected devices tick the checkbox next to the list number 
or insert the line. (Further details are described in chapter 7.5.2.) 
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6.5 Device settings 

The software reads out all device parameters by clicking the 
Device settings button and opens the remote programming and user settings 
window of the selected device. The software reads out the parameter values 
automatically. (Further details are described in chapter 7.6.) 
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This window shows the device specific settings. The window consists of two main 
parts, on the left there is a navigation screen and on the right the modifiable 
settings are listed. 
 
The user selectable parameters of the Device Identification 
menu are the following: 
Short (HART) address 1  
Name tag 2  
Descriptor 3  
Date 4  
Message 5  
 
The previous values (before the modification) can be read out by clicking the 
Refresh 6 , 7  button. 
The modifications can be applied and send to the transmitter by clicking the  
Send 8  button. To exit from the Device settings window just simply close the 
window.  
 

6.6 Start measurement 

To start the measurement, tick the checkbox next to the list number of the 
detected device. Then the inactive Polling button becomes active. 
(Further details are described in the end of chapter 7.5.) 
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To start visualize the measurement values click Polling 1  button. 
The opened small window shows cycle queried information, measured values 2  
and a Status „LED” 3  
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6.7 Trend logging 

 
 
Since the Polling (querying the measurement data) is started (the maximal time 
limit is 3 hours) then the values can be displayed on a Trend Diagram. 
 
Click the Trend Window On button in the upper menu bar or in the Device list 
window click the right mouse button on the line of the selected device to see the 
popup command list menu with more functions. Choose the Trend Window On 
command from this list menu. (Further details are described in chapter 8.2.) 
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The Trend Diagram window appears. 

 
 
In the Trend Diagram window the right click popup menu provides many new 
settings. 
For example here you can find the data-logging settings or start the Recording by 
pressing F6 or click Recording → Start command in the menu. Then the 
recorded Trend Diagram can be saved. (Further details are described in 
chapter 8.2.) 
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Then a new window appears where the following settings should be selected for 
saving into file: 

 File type 1 , 
 File path 2 , 
 Date and time format 3 , 

 

The header settings of the saved file can be selected: 
 Name of the header datafields 4 , 
 Whether include the header datafields 5 , and attach units to the 

datafields 6  
 

Click the OK button to apply the settings. 
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Click the Save Trend command (Ctrl+F6) to save the measurement data to file 
and also select the saving settings when the Recording is in Stop state. 
In this case the above setting window appears again with the same saving 
settings. 
(Further details are described in chapter 8.2.) 
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7. Detailed description of the software 

7.1 Running the application 

Run the application with NUS-NTB-MRM-SW.exe file. 
 

7.2 Running the application 

The following main screen appears as welcome screen: 
 

 
 
The main screen contains the following elements: 
Menu bar: File, Device, Network, Setup, Tools, View, Window, Help 
Quick buttons: Add network, Detect start all node 
 
The language (English, etc…) can be selected at the Language menu point in the 
Setup menu. 
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7.3 Elements of the main screen 

In the drop-down menus of the menu bar the following functions can be reached: 
 

7.3.1 File menu 
Exit from NUS-NTB-NRM-SW (Alt+F4). 
 

7.3.2 Network menu 
From this menu Add Network (Ctrl + H), Del Network (Shift + Ctrl + D) and Del all 
Network can be selected. 

 
7.3.3 Setup 

In the Setup menu the language (English, etc… ) can be selected at the 
Language menu point. 
 

7.3.4 Tools 
In the Tools menu there are integrated tools like the Parameter File Editor & 
Viewer and the Record File Viewer. (Further details are described in 
chapter 9.) 
 

7.3.5 View 
Two functions can be found here: Node Log Window(s) and Project (F3). 
In the Node Log Window(s) menu point you can hide the communication log for 
the "Node window". With the "Show All""Hide All" options all communication logs 
can be opened or closed with one click.  
The Communication Log displays all incoming and outgoing communication 
messages including warning and error messages are monitored. 
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The Project menu command (F3) activates the Node list on the left side. If the tick 
is deactivated in the menu the Device list fills the entire place available in the 
window. 

 
 

 
 

7.3.6 Window 
In this menu you can select between the windows. The two options: Next window, 
Previous window can be used in case of multiple Nodes to scroll between the 
Nodes. 
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7.3.7 Help 
The About window shows the general information of NUS-NTB-NRM-SW, such as 
version number, registered user, date of release, contact e-mail address. 

 
 
 
 

7.4 Connection settings 

Click the Add network quick button to choose the communication port of the 
network to be added. The following window appears: 
 

 
 
Click the More button to reach further settings. New settings appear in addition to 
the Add networks window: 
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Tick the Special detect mode On to activate the special settings of the detection 
mode to be modified. The special settings are described in the following figure: 
 

 
 
1  Timeout time is the time until the software is waiting for the answer 

packets. 
2  Cycle time is the time until the software is waiting for the queried 

information.  
3  The HART short address range can be specified for the Device Detection. 
4  Modem selection 
5  Refresh 
6  When the ‘Only first detect’ checkbox is ticked the Device Detection ends 

when the first unit is detected. 
7  Ticking the ’Save settings as default’ checkbox and clicking on the OK 

button will save the actual network settings as default.  
8  With the ’Clear default settings’ button you can delete the user-saved 

default setting and can reset to factory default values. 
 
Click the OK button to apply the network selection. Then the device list appears 
and a new toolbar including the Detection button becomes available. 
 

7.5 Toolbar 

The appearing new toolbar contains the following menu points: 
 

 Detect, Node settings, Polling, Device settings, Calibration, Trend window 
on, Trend window close 
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7.5.1 Device list information 
 No.: List number (list numbers of the detected devices) 
 Address: HART® Short address („0” for single device, „1…15” for multiple 

devices on the HART® loop) 
 Factory: KOBOLD – given by HART® Communication Foundation 
 Device type: Type identification number of the HART® capable KOBOLD 

transmitters, - cannot be user modified 
 Device ID: The manufacturer’s electronic production number, - cannot be 

user modified 
 Tag: 8 byte device descriptor, usually order code, - can be modified by the 

user 
 Descriptor: Max. 16 byte arbitrary comment that can be assigned to the 

device and is generally operation principle-related, - can be modified by the 
user 

 Date: Can be assigned to the device (for example last modification of the 
Tag or Descriptor) - can be modified by the user 

 Message: Max. 32 byte arbitrary comment that can be assigned to the 
device and is generally operation-related, - can be modified by the user 

 Status: result of last programming or query data request: OK! or Error! 
 Time stamp: date of last data request 
 TX count: number of outgoing messages sent to a given device 
 RX count: number of incoming messages received from a given device 

 
 

 
 
Note 

Note! All data in the device list are queried from the devices. 

 
7.5.2 Overview on the toolbar 

With starting the Detect the connected devices appear in the device list. 
The software queries the transmitters through the HART® loop from address 0 to 
15 and lists them with a list number. The software detects the devices in 
accordance to the „Short address” that is why two or more devices must not have 
the same Short address. The „Short address” and the list number are not the 
same. The devices receive the „Short address” by the factory calibration by the 
manufacturer. 
The device detection procedure can be stopped or aborted by clicking the Abort 
button. Then a new window appears in order to confirm the abortion or go back to 
continue the detection. 
 
After the successfully finished device detection new command buttons became 
active in the toolbar (Polling - only if a device is selected by its checkbox next to 
its list number, Device Settings - with selecting the line of the device in the list,  
Calibration - only for pH analytical transmitters, Trend Window On - with selecting 
the line of the device in the list, Trend Window Close - when the trend window is 
opened). 
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Ticking the checkbox next to the list number of the selected device and clicking 
the activated ’Polling’ a new window appears. To select all devices in the list use 
the right mouse button popup menu and click the All measuring window On 
command. 
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The data fields such as ‘Short address’, ‘Tag’, ‘Descriptor’, ‘Message’, which are 
allowed for user modification which fields can be easily edited by double click on 
the device list. 
 
 

 
 
Note 

Warning! Modifying these parameters will result immediate changes in 
the device after pressing the Enter button. 
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When the Show device info window checkbox is ticked at the bottom, the 
Polling window will be added with further identification datafields. 
 
 

When the Polling button is clicked, the polling is started and the small window 
appears the continuous measurement data query starts. The maximum time 
interval of the Polling is 3 hours and the remaining time is indicated at the bottom 
status bar. To stop the measurement data query click again the Polling button. 
To close the Polling window untick the checkbox of the selected device or use the 
right mouse button popup menu and click the Close all measure window 
command. 
1  

 Cyclically queried information, 
 Measurement values, 
 Devices specific data, further details are described in the user’s and 

programming manuals of the selected instruments 
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2  
Status LED 
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7.6 Device settings 

After the successfully finished device detection all the connected devices appear 
in the device list. To modify device settings and perform remote programming the 
line of the device should be inserted. 
Opening the Device Settings window is possible only when the Polling is 
stopped. 
The device specific data and the detailed description of the programmable 
parameters of the transmitters can be found in the User’s & Programming manual 
of the selected device. The factory default parameter values can be also found in 
the manuals. 
By clicking the Device settings button a new window appears: 
 

 
 
The device settings (specified for the given instrument) are accessible by the 
following tabs on the left. 
If the device parameters are received from the device a new window appears 
containing the device settings specified for the given instrument: 
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Displayed Information screen contains: 
 
Device: Device name (series), Manufacturer, Serial number, Date, Hardware 
(HW) version, Firmware (SW) version 
Device Identification: Device Short HART® Address, Tag, Descriptor, Date, 
Message, - the last two options can be refreshed 
 
The settings are described in details in the user’s and programming manual of the 
given instrument.  
To apply any parameter modifications, click the Send button to send the 
new parameter values to the instrument. 
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Application: Selecting operation mode (level measurement in liquids or in 
solids), Selecting engineering system (Metric - EU, Imperial - US), Selecting unit 
for Primary Value (mm, cm, m; in, ft) 
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Outputs: Editing current output, relay output values 

Linearization curve: Further details are described in chapter 8.4. 
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Click the Advanced  button on the bottom left corner to reach further device 
settings specified for the given instrument, for example: 
Tag and Descriptor, Sensor info, Output and PV, Calibration, Parameters, VMT, 
Special, Echo map. 
 
 

 
 
Note 

These advanced functions are allowed to be modified only by trained 
personnel for own risk, because modifications in these parameters may 
have serious effects on the used processes controlled by the 
measurement instruments. 

 
 
By clicking the Advanced new menu points appear allowing configure additional 
device-specific features: 
At the Addressing section the Polling (HART® Short) address can be selected. 
(Further details are described in chapter 7.5 -Detection) 
Tag and Descriptor section: The Tag, Descriptor and the Date can be read out 
and modified. Click the Write button to apply the changes. 
Message section: An operation related message can be set here.  
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At the Parameters menu all user programmable device parameters are listed. 
Each parameter can be selected and then edited, get from the device or sent to 
the device, load from file and save to file.      
 Perform the following step to modify the device parameters: 
1. Tick the checkbox of the selected Parameter 1 . 
2. Click the Get 2  button to query to current parameter value. 
3. The modified parameters can be applied and saved by clicking the Send 

7  button, this case the parameters will be saved unless the procedure 
got cancelled. 

4. To save all parameters to a parameter list file click the Save 5  button. 
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To load the factory default values click the Load default 4  button. Then a 
‘Warning’ window appears in order to confirm loading the default values or cancel. 
The Refresh 6  (Refresh) button queries again all parameters from the 
instrument. If any modification is made the Send 7  button became active and all 
modifications can be sent to the instrument.  
By selecting any parameter with inserting the line use the right mouse button to 
open the popup menu for further commands: Select all, Deselect all, Select invert, 
Only select the parameters, Only select the info parameters, Edit parameters, Set 
to default value, Set to last value. 
 
VMT (Further details are described in chapter 8.4) 

 
 
Echo map is a device specific (for non-contact principle) function. 
 
By clicking the Get button the following echo data will be displayed: List number 
of the echoes, Distance, Amplitude in dB, Status. 
 
By clicking the Show Diagram button an Echo Map appears displaying the place 
of the received echo in the distant axis. The screen can be zoomed in and out 
and can be scrolled with the scrollbar tool at the bottom. 
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Note 

Warning! Please note that the echo diagram does not show the real 
echo map, but only gives visual equivalent to the data in the echo 
table! 

 
When ticking the ‘Auto Refresh’ checkbox under the Get button and click the Get 
button a continuous cyclic Echo map querying will start with the selected cycle 
time. The cyclic querying can be stopped by clicking Cancel, or stops 
automatically if you leave the Echo Map window or close the Device Settings 
window between two cycles. With inserting the line of the received echo use the 
right mouse button to open the popup menu list with the following commands: 
Get, Auto refresh, Show Diagram, Save to file 
By clicking the Save to file.. button the Echo Map can be saved to an Echo Map 
file in ‘csv’ format. To leave the Advanced menu and go back to the Basic settings 
click the Basic button. 
To go back to the Device list simply close the window (Alt+F4). 
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8. The Popup menu 

8.1 Elements of the Popup menu 

Many commands are available in the right mouse button popup menu; however, 
some of them are only available after the successful device detection. The 
elements of the right mouse button popup menu are the following: 

 Detect 
 Stop detect 
 Polling on/off 
 Node settings 
 Device settings 
 Device calibration 
 All measuring window on 
 Close all measuring 

window 

 Select invert 
 Trend window on 
 Trend window close 
 All Trend window on 
 Close all Trend window 
 Show Device Status 

Window 
 Log window On/Off 

 

 
 
The commands of the popup menu such as Detect, Stop detect, Polling On/Off, 
and the Node settings has exactly the same function as the equivalent quick 
buttons in the menu bar. 
 
The All measuring window On command selects all detected devices in the 
device list by ticking the checkboxes. Then the Polling command (or button) will 
open all measuring windows and start the query of all measurement data. 
 
The multiple measurement windows can be closed by one click with the All 
measuring window close command. 
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8.2 Trend diagram 

When the Polling is running the Trend Diagram function becomes available to 
open: 
The selected measurement value is displayed, marked with the checkbox. 
 

 
 
At the bottom section the measured value to be displayed can be selected: 
Primary Value, Current value, Lev, Lev%. Of course, the displayable 
measurement values are in accordance to the selected instrument. Since the 
running Polling function is needed for the operation of the Trend Diagram, the 
maximal time interval is also 3 hours. 
 
The right mouse button popup menu provides further commands to use: 
Recording, Save Trend, Clear diagram, Zoom, Panels, Archive settings, Series, 
Diagram settings. The drop-down popup menu has many elements with multiple 
sub-menus. 
 
In the Recording drop-down menu Start and Stop commands can be selected. 
Both Start and Stop functions are available with F6 / F7 keyboard quick buttons. 
By clicking the Start button a new window appears with the file saving settings. 
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In the Archive settings window the File type, Folder path, Date & Time format, 
Header options can be set. When clicking the Stop command the saving into file 
will be stopped. If we want to continue to saving, click again the Start command 
to continue the saving into the previously selected file. If we want to use a new 
file for saving use the right mouse button popup menu and select the Archive 
settings menu and then click the Settings command to open the above-
described Archive settings window. After filling the required settings click the OK 
button to start saving into the new file. 
If the header function “Attached unit to data field” is marked, the data are saved 
into the same selected file. If not you’ll get an error popup! 
 

 
 

The Save Trend command (or button in the Right panel) opens the above-
described Archive settings window if the saving path was not set previously. The 
Save Trend command is counted from the first moment (when the Polling was 
started) and takes only until the moment of clicking the Save trend command or 
the OK button of the Archive settings window.  

 

Click the Clear diagram command to clear the previously made Trend diagram. 
This function has no effect on the saved trend diagram files. 

 

In the Zoom menu there are many possible options for customizing the diagram: 
Zoom+, Zoom-, Reset Zoom. 
 
The Panel menu has multiple drop-down menus: Left Panel, Right Panel, Bottom 
panel, Buttons panel, All Panels On/Off. All menu points have other sub-menus 
allowing further setting possibilities.  
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The Left Panel which is a toolbar panel on the left side includes the 
measurement values and the device info screen of the Polling window. The Left 
Panel can be customized by the right click popup menu with turning on or off the 
‘Show Measured Value’ and the ’Show device info’ options. 

 
 
The Right Panel which is also a toolbar panel but on the right side including 
Archive Info, Archive settings and quick buttons related to the Recording menu. 
The Right Panel can be customized by the right click popup menu with turning on 
or off the ‘Show Archive Info’, and the Show Archive settings’ options. 

 
In the Archive settings the measured values can be selected which will be saved 
to file. Clicking the Start or the Save Trend will perform saving in accordance to 
the above described. The Settings button opens the Archive settings window. 
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In the Panels -> Bottom Panel menu there is a Show Bottoms Panel command 
activating a Browse toolbar under the diagram. 

 
 
When the saving path has been already selected it is displayed here. 
 
In the Panels -> Button Panel menu there is a Show Buttons Panel command 
activating quick buttons under the diagram: 

 
 
The appeared quick buttons: Zoom+, Zoom-, Reset Zoom, Diagram settings 
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The All Panels On/Off command is able to open or close all additional panels of 
the Trend Diagram with only one click. 

 
 

8.3 Status 

By clicking the Show Device Status Window command in the right mouse 
button popup menu, a Status and error information window appears. This 
information window is read-only and the actual status can be queried by clicking 
the Refresh button at the bottom. When any data transfer (read or write) is 
happening the status information is automatically get refreshed and the Refresh 
button became inactive. 
 
In the Status window there are device specific information displayed such as: 
Calculation mode, Relay operation, Factory settings, Simulation, etc.. 
Error indication is displayed in the Error window. 
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8.4 Linearization (VMT - Volume Mass Table) 

In the Linearization curve menu point of the Device settings (see chapter 7.6.) 
the linearization can be turned ON or OFF. 

 
 
The required setting can be applied by Send button. 
 
The level, volume or flow values can be assigned to the measured values with 
the help of linearization. This can be advantageous in case of (level – level 
assignment for) different sound velocity (various gaseous media then the air) or 
lying cylindrical tank (level – volume assignment). 
 
The point pairs of the linearization table forms a max. 2x99 matrix displayed in 5 
columns with separated columns for the dimensions for the source and the output 
values. The Source column contains the measurement values and the Output 
column contains the calibrated or calculated values. 
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The VMT table can be accessed in the Advanced menu: 

 
 
Click the Get button to read out the linearization table data from the device: 
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The right mouse button popup menu provides the following options:  
 Edit item, 
 Add new item, 
 Insert new item, 
 Delete the contents, 
 Delete item, 
 Select all, 
 Deselect all, 
 Select invert, 
 Delete the contents of the 

all items, 
 Delete „Empty” items, 

 Renumbering, 
 Get VMT items from the 

device, 
 Send VMT items to the 

device, 
 Delete all VMT items from 

the device, 
 Load VMT list items from 

file, 
 Save VMT list items to file. 

 
The Edit item command opens a new window for editing a VMT value pair by 
entering the source and the output value. 

 
If the linearization table is not full and there is free space then the Add new item 
and Insert new item command is active in the right mouse button popup menu. 
 
Click the Delete the contents of the selected items command to delete the 
content from more selected VMT items: 
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Click the Get VMT items from the device. Command to query the content of the 
linearization table: 

 
 
 
Click the Delete item(s) command to delete entirely the selected VMT item(s) 
 
Click the Delete „empty” items command to delete the VMT items not 
containing value pairs. 
 
Click the Renumbering command to refresh the list numbers of the VMT items. 
The Send VMT items to the device... command uploads the linearization data to 
the device. 
If we have an existing VMT list file we can load it by clicking the Load VMT list 
items from file command. Then a new window appears where the file can be 
browsed: 
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The VMT list can be saved to file by clicking the Save VMT list items to file 
command. Then the above-described new window appears where the folder can 
be browsed where the file will be saved with the entered file name. 
We can choose from multiple file formats for the loading / saving, the VMT data 
can be saved in *.csv file format which can be read and write with Excel if the 
header format is standard. 
 
 
 

9. Tools menu 

In the Tools menu there are integrated, the configuration software related tools 
which perform handy features like the Parameter File Editor & Viewer and the 
Record File Viewer. 
 

9.1  Parameter file editor and viewer 

The Parameter File Editor & Viewer is an additional tool which provides possibility 
to view, handle and even edit the operation parameters of any unconnected 
transmitter (in offline mode). 
 
Its usage is very simple; the operation of this tool is very similar to the Advanced 
mode / Parameters window. 
 
By clicking the Parameter File Editor & Viewer menu point in the Tools menu the 
following window appears: 
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There are 3 buttons at the bottom part, ’Save to file...’, ’Load from file...’ and the 
’Apply’ from which only the ’Load from file...’ is active by default. 

 
By clicking the ’Load from file...’ button a browsing window appears where a 
previously saved parameter list file can be browsed and opened by clicking the 
‘Open’ button. 

 
The software automatically evaluates the parameter values during the loading 
and checks if the values are within the acceptable range and marks the elements 
which have wrong value. 
After the successful loading the parameters and the values are displayed in table 
form: 
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In the upper side the ’Loaded Device Type’ indicates the device type which 
parameters are listed, and the rest of the window shows the parameters and the 
values. The first column of the table (P.No.) contains the number and the name of 
the parameter, the second contains the parameter values, the third contains the 
possible units. The selected parameter values can be edited by double-click or 
pressing the ‘Enter’ button, or by the right-click popup menu ‘Edit parameters’ 
command. If the selected parameter is allowed for user modification (or it is not a 
read-only parameter) then an Edit window appears. 
 

 
This window provides possibility to modify a parameter value in accordance to the 
User’s and programming manual of the given transmitter. Click the ‘OK’ button to 
modify the value. When pressing the ‘ESC’ key or clicking the ‘Cancel’ button the 
parameter value will not be modified. 
 
The modified parameter values can be saved with overwriting the previously used 
parameter list file, or create a new one by clicking the ‘Save to file..’ button. The 
parameters to be saved can be selected by ticking the checkbox. 
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Note! Only the selected (by ticking the checkbox) parameters will be saved! 
 
By clicking the ‘Save to file..’ button a browsing window appears where the saving 
path should be selected and the file name should be entered.  

 
 
After entering the file name click the ’Save’ button for saving the selected 
parameters to file. By clicking the ’Cancel’ button or pressing the ’ESC’ key we 
can go back to the Parameter File Editor and Viewer window without saving the 
parameters to file. 
After the successful saving to file an Information window appears notifying that 
the parameters saved successfully done and indicating the number of the saved 
parameters. 
By clicking the ’Ok’ button you get back to the Parameter File Editor and Viewer 
window. 
 

 
To go exit from the Parameter File Editor & Viewer simply close the window 
(Alt+F4). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



NUS-NTB-NRM-SW Software 

page 52  NUS-NTB-NRM-SW Software V2.1-K08/0625 

10. Disposal 

See “General Safety Instructions” - via the QR code on the device or via 
www.kobold.com 


